
Computational Workshop 
#2:

Predicting physicochemical properties, 
linear response calculations, Monte Carlo 

simulations and virtual screening



Sampling methods
Biomolecules: 
• mul,dimensional poten,al energy surface (PES) 
• Parts of PES can be rela,vely flat

à Weak noncovalent interac,ons à barriers are low

System’s properties must be represented by ensemble of 
states and NOT a single state

Geometry op*miza*on to 

local energy minimum



Sampling methods

n1/n0 = e-DG/kT

à If [AChE]tissue ~ 10-5 mol/kg then there 
are ~1x1018 molecules in 1kg

à at 310K, ca. 1/10 will be ‘purple’ not 
brown!!! 

Different poses of TPP
bound in acetylcholinesterase

Binding affinities (kcal/mol):
Blue = -5.2  Brown = -8.5 Purple = -7.1 

What is the relative population of brown and purple states?



Monte Carlo simula4ons
• Generate an ensemble of states by producing random configurations 

of the system weighted by their Boltzmann probabilities
• this process would yield an unrealistically large ensemble à importance 

sampling (Metropolis method) produces configurations with a probability 
proportional to their Boltzmann factors (biases sampling toward low energy 
structures)
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Linux commands review:

• Linux Cheat Sheets: 
• h/ps://linoxide.com/guide/linux-cheat-

sheet.png
• h/ps://upload.wikimedia.org/wikipedi

a/commons/7/79/Unix_command_che
atsheet.pdf

https://linoxide.com/guide/linux-cheat-sheet.png
https://upload.wikimedia.org/wikipedia/commons/7/79/Unix_command_cheatsheet.pdf


Outline of software for today’s webinar
• QikProp – quick property prediction program for drug-like molecules 

and other commercial chemicals
• http://gohom.win/ManualHom/Schrodinger/Schrodinger_2012_docs/qikprop

/qikprop_user_manual.pdf

• BOSS – Computational Chemistry software
• Monte Carlo simulations in condensed phases
• Linear Response calculations
• Manuals:

• http://zarbi.chem.yale.edu/doc/boss49.pdf
• http://zarbi.chem.yale.edu/doc/MCPROman230.pdf

• Virtual screening (Docking+Scoring)
• Protein-Ligand Docking & Simulations using Vina and Mcule

http://gohom.win/ManualHom/Schrodinger/Schrodinger_2012_docs/qikprop/qikprop_user_manual.pdf
http://zarbi.chem.yale.edu/doc/boss49.pdf
http://zarbi.chem.yale.edu/doc/MCPROman230.pdf


Star4ng with the simplest: Qikprop

INPUT prep:

draw any structure in MarvinSketch, hydrogenize and optimize in 3D and save 
as .pdb file



QikProp

To run a Qikprop calculation execute the following:
./xQPROP filename or qikprop [options] filename

Example options are:



Qikprop Output Files



ANALYZING QikProp output

QP Manual contains linear model stats for all properties predicted



Molecular Modeling of Organic and 
Biomolecular Systems Using BOSS
• A program that performs:
• Monte Carlo (MC) stabsbcal mechanic simulabons on chemicals systems
• Energy opbmizabons and conformabonal searching 
• Linear response calculabons to predict properbes from MC simulabons

• QM, MM and QM/MM capability:
• OPLS-AA and OPLS-UA force fields
• QM: focus on semiempirical methods: AM1, PM3, PDDG/PM3, PDDG/MNDO
• Quantum mechanical charges: CM1 and CM3

mon application of MCPRO to date has been MC/FEP computation of
relative free energies of binding for protein–ligand complexes; this
may focus on the effects of either modifying the ligand25 or the
protein.26

Energy and Free Energy Evaluation

The molecular mechanics calculations typically use the OPLS-AA
force field,2 which is nearly identical in form to other popular force

fields such as AMBER and CHARMM.27,28 The energy expres-
sion consists of harmonic terms for bond stretching and angle
bending, a Fourier series for each torsional angle, and Coulomb
and Lennard–Jones interactions between atoms separated by three
or more bonds [eqs. (1)–(4)]. The latter “nonbonded” interactions
are also evaluated between intermolecular atom pairs to yield the
intermolecular energy , and they are reduced by a factor of 2 for
intramolecular 1,4-interactions. Geometric combining rules are

Figure 2. Folding of the U(1-17)T9D heptadecapeptide using MCPRO, the OPLS-AA force field, GB/SA
hydration, and the CRA backbone sampling algorithm. Left: start of the MC run. Middle: after 24 million
MC steps. Right: NMR structure 1e0q. The backbone RMSD is 2.5 Å between the computed and NMR
structures. See ref. 22 for details.

Figure 3. One configuration of the transition structure from a
QM/MM MC/FEP simulation for the reaction of ethyl chloride with
chloride ion in TIP4P water. See ref. 43 for more details. A few of the
500 water molecules in front of the solute have been removed for
clarity.

Figure 4. A configuration from a Monte Carlo simulation of efavirenz
(Sustiva) bound to HIV-1 reverse transcriptase (HIV-RT). Results
from MC/FEP calculations using MCPRO provided confidence in the
predicted structure for the efavirenz/HIV-RT complex in ref. 50 and
distinguished between two alternative X-ray structures for the complex
of efavirenz with the clinically important K103N mutant of HIV-RT in
ref. 25.
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Force field recap:

• Energies computed as a function of bond distances, angles, torsions 
and interatomic interactions:  

used for the Lennard–Jones parameters, that is, !ij ! (!i!j)
1/2 and

"ij ! ("i"j)
1/2. The total energy then consists of these terms

evaluated for all particles in the system; optional, additional terms
are (1) harmonic restraints on interatomic distances, dihedral an-
gles, or for an atom to a point in space, (2) flat-bottomed harmonic
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potentials as NOE (nuclear Overhauser effect) restraints, (3) a
half-harmonic restoring potential when a solvent cap is used to
inhibit solvent evaporation, (4) the Ewald energy for long-range
electrostatics in periodic systems, (5) an energy correction for the
Lennard–Jones interactions neglected beyond the cutoffs for non-
aqueous solvents or pure liquids, and (6) the GB/SA solvation
energy. There are also many other options, as designated in the
“parameter file” for use in specialized cases. For example, one can
perform “multiple-copy” calculations by declaring that solute–
solute or solvent–solvent interactions are not to be evaluated.
Thus, one could have a protein as a solute and solvate with
thousands of probe molecules; then an MC simulation or energy
minimization could be performed to determine where the probes
cluster in the protein.29

When the force field is used, the OPLS atom-type number for
each atom is specified in the solute Z-matrix (Fig. 1). The corre-
sponding parameters are extracted automatically from the oplsaa-
.par (nonbonded and torsion) and olpsaa.sb (bond stretch and
angle bend) parameter files that are provided with the programs,
and which may be edited to add new parameters. The specification
of the nonbonded parameters in oplsaa.par covers the atomic
charge q, the Lennard–Jones parameters, ! and ", and designation
of a general atom type, for example, CT for aliphatic carbon or NZ
for a cyano nitrogen. These two-letter codes are then used for
retrieval of the bond stretching, angle bending, and torsion param-
eters. Thus, a calculation for butane requires CT–CT and CT–HC
stretching, CT–CT–CT, HC–CT–CT, and HC–CT–HC bending,
and HC–CT–CT–HC, HC–CT–CT–CT, and CT–CT–CT–CT tor-
sion parameters. If any parameters are missing, warnings are
issued, and synonym and estimation procedures, based on the
two-letter codes, are invoked to provide estimated values. Im-
proper torsions, which are often used to hinder pyramidilization at

trigonal centers, are implemented by designating nonzero V2 terms
in eq. (3).

The Monte Carlo sampling in BOSS and MCPRO uses stan-
dard procedures including the Metropolis algorithm.13 For a
periodic system of flexible molecules, an attempted MC move
consists of randomly picking one molecule, translating it ran-
domly in all three Cartesian directions, randomly rotating it
about one randomly chosen Cartesian axis, and rebuilding the
molecule from its Z-matrix with random changes to any desig-
nated bond lengths, bond angles, and dihedral angles. The
ranges for the random variations are adjusted during the equil-
ibration phase to give acceptance probabilities for new config-
urations of ca. 40%. This procedure does not introduce nonuni-
tary Jacobian terms in the MC transition probabilities that could
be introduced, for example, by use of spherical coordinates or
Euler angles. This is verified by performing MC simulations of
purely harmonic systems such as a triatomic with two bond
stretching and one angle bending terms; the computed potential
energy in this case must agree with the equipartition result of
(3/2)kBT. For MC simulations in the NPT ensemble, attempted
changes to the volume of the periodic system are also made
periodically. This can be done by randomly scaling the posi-
tions of all molecules outward or inward. In this case, the
Metropolis test features comparison of exp[)(E * PV ) NkBT
ln V)/kBT] for the new and old configurations.13

Atomic Charges and the OPLS/CM1A Force Field

OPLS-AA parameters have been explicitly developed for many
organic functional groups, and missing bond stretching, angle
bending, torsion, and Lennard–Jones parameters can usually be
well estimated. For an arbitrary new molecule with a functional
group or heterocycle that does not have OPLS-AA parameters, the
principal problem is then the assignment of the partial atomic
charges, q, for eqs. (4) and (5). The most common solution has
been to perform a QM calculation and to fit the charges to repro-
duce electronic properties, especially dipole moments and electro-
static potentials. This has led to several common alternatives such
as CHELPG and RESP charges that are usually derived from ab
initio wave functions, and faster approaches using, for example,
semiempirical QM charges.30 Our own preference has been for the
CM charges of Cramer, Truhlar, and coworkers, which are derived
from AM1 or PM3 calculations.31,32 Their rapid procedures, which
yield highly accurate dipole moments, are incorporated directly
into BOSS and MCPRO for computing charges for arbitrary or-
ganic molecules for both force-field and QM/MM calculations.
Some symmetrization of the CM charges is performed such that
the charges for monovalent atoms Y in XY2 or XY3 groups are
made to be the same, as are charges for equivalent carbons and
hydrogens in substituted benzenes. Without this modification, for
example, QM charges for the ortho hydrogens in phenol would be
different. This is particularly undesirable for conformational
searching, because it leads to structurally equivalent minima with
different energies.

The CM alternatives have been tested in computations of free
energies of hydration in TIP4P water.33 The best results come from
the AM1-based CM1A charges scaled by 1.14 for neutral mole-
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How is system’s energy calculated?

From BOSS output: 
total E = ESS + ESX + EXX + EBND + EBC + EANG + EDIH + ENB + ECUT + ESINT 

• ESS = the solvent-solvent energy,

• ESX = the solvent-solute energy,

• EXX = the solute-solute (intersolute) energy,

• EBND = the bond stretching energy for the solutes,

• EBC = the energy for the harmonic restraints,

• EANG = the angle bending energy for the solutes,

• EDIH = the torsional energy for the solutes,

• ENB = the >1,3 intramolecular non-bonded energy for the solutes, and

• ECUT = the cutoff correcMon for the Lennard-Jones interacMons neglected beyond the cutoff for non-aqueous solvents,

• ESINT = the intramolecular energy for flexible solvent molecules, = ESBND + ESANG + ESDIH + ESNB 

The PDDG methods were then parameterized for halogens8

and dramatic improvements were obtained for the !Hf mues of
442 F, Cl, Br, and I-containing compounds: MNDO (14.0),
AM1 (11.1), PM3 (8.1), PDDG/MNDO (6.6), and PDDG/PM3
(5.6 kcal/mol). The error here for PDDG/PM3 comes predom-
inantly from polyfluoro compounds. Hydrogen-bonded and ion–
molecule complexes and transition states were also in the
training set; the results are similar to those from B3LYP/6-
311""G(d,p). These items were not in the original CHNO
training set,7 and although the results are better than for AM1,
significant improvements were not made in these areas over
PM3. The PDDG/PM3 parameterization for Si, P, and S has
also been completed with particularly large improvements for
sulfur compounds including hypervalent ones.40 !Hf mues for
249 S-containing compounds are MNDO (41.2), AM1 (10.6),
PM3 (10.5), MNDO/d (10.0), and PDDG/PM3 (6.4). Current
work is focusing on reintroduction of the overlap integrals in
the secular determinant; in particular, good success has been
obtained with a nonorthogonal PM3 method with simultaneous
parameterization for ground and transition states.

QM/MM Calculations

The implemented QM/MM methodology allows designation of
multiple solute molecules and/or residues of biomolecules to be
treated by the SQM methods and the remainder of the system by
MM and/or GB/SA [eq. (7)].3 For the typical case of QM solutes
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in a MM solvent, the QM/MM energy is given by the non-
bonded terms in eq. (8), where the q i for the QM atoms are the
CM1 charges (scaled by 1.14 for neutral molecules) and the q j

are OPLS-AA charges, and standard OPLS-AA Lennard–Jones
parameters are used based on the two-letter codes. In an MC
simulation, on each attempted move of a solute, the QM energy
and CM charges are computed for the new structure and they
are used in the new Etotal. The old density matrix is used in the
first SCF cycle to speed convergence. Furthermore, for an
MC/FEP calculation, if the attempted move is accepted, the QM

and CM calculations are then performed for the perturbed
versions of the solutes to evaluate Etotal for the perturbed
systems. For enzymatic reactions in which a subset of the amino
acid residues is treated by QM, a link-atom procedure is used to
meld the QM and MM parts of the protein.24 The partition is
performed along the backbone; the link atoms are hydrogens
with bonds to the QM region elongated by ca. 0.5 Å so that the
hydrogens and C& atoms overlap (Scheme 1). In this manner,
the link atom and its C& form constitute a single particle that
works collectively to interact with the system.

Results of QM/MM calculations using BOSS or MCPRO
have been reported that well reproduce observed free energies
of hydration for 25 diverse organic molecules,33 and solvent
effects for conformational equilibria,3 the parent Claisen rear-
rangement,3 three Diels–Alder reactions,37 the chorismate to
prephenate Claisen rearrangement in water, methanol, and cat-
alyzed by chorismate mutase,41,42 SN2 reactions (Fig. 3),43 the
N3

) " p -FPhNO2 SNAr reaction and Kemp decarboxylations.38

A recent study clarified the mechanism for the reaction of
2-pyrone derivatives catalyzed by macrophomate synthase as a
tandem Michael-aldol sequence rather than a Diels–Alder re-
action (Scheme 2).24 Most cases involve locating the stationary
points on computed two-dimensional free energy surfaces or
“potentials of mean force” (pmfs). The studies for SN2 and
SNAr reactions and the Kemp decarboxylations used PDDG/
PM3 for the QM and yielded solution-phase activation barriers
in excellent accord with experiment. The gas-phase results for
the SN2 reactions are virtually identical for PDDG/PM3 and
CBS-QB3.43 The rate retardation for SN2 reactions on neopen-
tyl halides was confirmed to be a steric effect in all media in
contrast to a provocative experimental report.43 The computa-
tions have been highly automated such that an entire reaction
profile can be computed via one job submission.

Free-Energy Perturbation Calculations

The MC/FEP calculations use the Zwanzig expression [eq. (9)]18

to compute the free energy change between a reference system 0
and a perturbed system 1.16–19 The average is taken for sampling
configurations of the reference system. For potential-of-mean-Scheme 1

Scheme 2
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mon application of MCPRO to date has been MC/FEP computation of
relative free energies of binding for protein–ligand complexes; this
may focus on the effects of either modifying the ligand25 or the
protein.26

Energy and Free Energy Evaluation

The molecular mechanics calculations typically use the OPLS-AA
force field,2 which is nearly identical in form to other popular force

fields such as AMBER and CHARMM.27,28 The energy expres-
sion consists of harmonic terms for bond stretching and angle
bending, a Fourier series for each torsional angle, and Coulomb
and Lennard–Jones interactions between atoms separated by three
or more bonds [eqs. (1)–(4)]. The latter “nonbonded” interactions
are also evaluated between intermolecular atom pairs to yield the
intermolecular energy , and they are reduced by a factor of 2 for
intramolecular 1,4-interactions. Geometric combining rules are

Figure 2. Folding of the U(1-17)T9D heptadecapeptide using MCPRO, the OPLS-AA force field, GB/SA
hydration, and the CRA backbone sampling algorithm. Left: start of the MC run. Middle: after 24 million
MC steps. Right: NMR structure 1e0q. The backbone RMSD is 2.5 Å between the computed and NMR
structures. See ref. 22 for details.

Figure 3. One configuration of the transition structure from a
QM/MM MC/FEP simulation for the reaction of ethyl chloride with
chloride ion in TIP4P water. See ref. 43 for more details. A few of the
500 water molecules in front of the solute have been removed for
clarity.

Figure 4. A configuration from a Monte Carlo simulation of efavirenz
(Sustiva) bound to HIV-1 reverse transcriptase (HIV-RT). Results
from MC/FEP calculations using MCPRO provided confidence in the
predicted structure for the efavirenz/HIV-RT complex in ref. 50 and
distinguished between two alternative X-ray structures for the complex
of efavirenz with the clinically important K103N mutant of HIV-RT in
ref. 25.
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How to run a Monte Carlo simula4on in BOSS

1. Generate a PDB of the desired solute molecule using MarvinSketch

Methanol



2. Convert PDB to Z-matrix with ligpargen : 
http://zarbi.chem.yale.edu/ligpargen/

http://zarbi.chem.yale.edu/ligpargen/


Zmat Format
Bond length Bond angle Dihedral 

Section to perturb internal 
degrees of freedom Bond lengths that 

will be sampled 
during the 
simulation 

Bond angles that will 
be sampled during 
the simulaTon 

Dihedrals that will be 
sampled followed by 
the range of sampling 

Atom label, Charge,   sigma,    epsilon 



How to run an MC simulation

3. Edit your parameter (par) file: 
Available solvents: Water, Methanol, Acetonictrile, Dimethyl ether, Propane, Chlorofrom, 
Methylene Chloride, Tetrahydrofuran, Argon, Carbon Tetrachloride, Dimethyl Sulfoxide 

Box size (molecule count, NMOL – remove # of 
solvent molecules that corresponds to # of heavy 
atoms, i.e. non-Hs, in the solute): 

Temperature (C) and pressure (atm) can be adjusted 
to mimic experimental conditions:  

REFER TO THE MANUAL FOR APPROPRIATE KEYWORDS
AND AVAILABLE OPTIONS!

CM1 = charge model
1.20 = scaling factor (0 for charged systems)
0   0   0   = charge, e.g. for anion this would be -1   -1   -1 



How to run an MC simulation

4. Your command (cmd) file
Only edit the configuraXons and ZMATRIX, (SLVZMAT in rare 
cases for custom solvents)

Submit the calculation with:    csh liqcmd >& log & 



Results

h/ps://www.cgl.ucsf.edu/chimera/plt files can be viewed in CHIMERA (a viewing software from UCSF)

https://www.cgl.ucsf.edu/chimera/


Results – ote file = full output  
1. Plots showing the history for several variable dihedral angles in the solutes
2. The final total energy and its components along with the parameters for the simulaXon as above
3. The final coordinates, solvent accessible surface area and volume for the solutes
4. The averages for the thermodynamic properXes including the two free energies which are 

repeated in fuller form below, average numbers of solute-solvent hydrogen bonds, The solute-
solvent atom-atom radial distribuXon funcXons and their integrals (coordinaXon numbers) that 
have been requested in the parameter file

5. The solvent-solvent and solute-solvent total energy and energy pair distribuXon funcXons
6. The distribuXon funcXons for the variable dihedral angles
7. The record of a`empted and accepted moves for each solvent and solute molecule
8. The full report on the computed thermodynamic results including the averages for each run, the 

total averages and the standard deviaXons calculated from the fluctuaXons in the averages for 
each run.



Linear Response Calculations 

• Using the same Zmatrix
• Similar to the previous calculaXons, linear responses can be done in a 

variety of solvents, but prebuilt linear models are trained on aqueous 
soluXons (TIP4P water model in BOSS)
• Uses the same Zmatrix, par, and cmd files – refer to this directory
• To execute just execute 

./xLMCPHERE ‘filename’ 



What Linear Response Calculations Do

1. Make a directory for the output files
2. Execute PM3 single-point calculation
3. Optimize geometry 
4. Recompute charges with PM3 single-point
5. Run an MC job (what we just discussed) 
• Uses the command file in directory 

6. Compute Properties



Linear Response 
Property Output

./xLMCPHERE ‘filename’



AutoDock

• AutoDock Tools(ADT) is needed for this secXon it can be downloaded 
here: h`p://autodock.scripps.edu/resources/adt

hfps://ccsb.scripps.edu/mgltools/

• Works with Mac, Windows and Linux machines
• Will NOT work with Cablina OS on macs
• If adt is needed for your work and you only have access to a Mac with Cablina

OS you can install a virtual machine on your personal computer: 
hfps://www.virtualbox.org/wiki/Downloads to use a different OS compabble 
with ADT 

http://autodock.scripps.edu/resources/adt
https://ccsb.scripps.edu/mgltools/
https://www.virtualbox.org/wiki/Downloads


Download 3D structure of Acetylcholinesterase (pdb id: 4m0e) from www.rcsb.org
as pdb format (4m0e.pdb)

Molecular Docking with AutoDock Vina

http://www.rcsb.org/


Open 4m0e.pdb in chimera:
→Select → Chain → B                              

#The protein is a dimer you will only need one chain 
so you are deleting the other
→Select → Residue→all nonstandard
→Actions→ Atoms/Bond→Delete
#This will delete any ligands, ions, etc that are bound to 
the protein
→Tools→Structure Editing→DockPrep
#This brings up the menu to prepare the structure for 
docking: Deletes any solvent molecules, adds H’s, 
charge, and fixes incomplete side chains

Uncheck Mol2 file, we will save the structure as a pdb
to use in further prep for docking

Prepare your protein for Docking using the Dockprep function of Chimera 
to add hydrogens, remove solvent ions, excess ligands, cofactors, or 

subunits, and repair incomplete side chains



Change the selecTon from “Residue-name-
based” (default) to “Unspecified 
(determined by method)” 

#Residue-name-based will simply assign a 
default protonaTon state based on the name 
of the residue

Ex) HIP = doubly protonated hisTdine

We want to instead calculate the 
protonaTon states 

Prepare your protein for Docking using the Dockprep function of Chimera 
to add hydrogens, remove solvent ions, excess ligands, cofactors, or 

subunits, and repair incomplete side chains



Select the AM1-BCC charges

Prepare your protein for Docking using the Dockprep func<on of Chimera 
to add hydrogens, remove solvent ions, excess ligands, cofactors, or 

subunits, and repair incomplete side chains



File -> Save PDB

Pick a name that 
indicates the 
changes/prep you’ve 
done

Save your prepped protein as a pdb



Preparing Ligand with Marvin

l Open MarvinSketch and draw your structure:
l Triphenyl phosphate with a chlorine substituted in the para 

position 

l Use clean in 3D to get a loosely op<mized structure:
l Structure → Clean 3D → Clean in 3D
l (it will look crazy because its 3 dimensions shown in 2, don't 

worry)

l Save as a pdb:
l File → Save as → “Ligand.pdb”



Use Autodock tools to prepare input file of 
ligand for docking with Autodock Vina

l Open Autodock tools
l Ligand → Input → Open → TPP.pdb
l Ligand → Choose torsions (are they correct?) → Done
l Ligand → Output → TPP.pdb → save TPP.pdbqt
l Close Autodock tools



l Open Autodock tools
l Open the pdb of your protein that you prepped in Chimera:

- File → Read molecule → 4m0eAprep.pdb
- Edit → Delete water (should already be done)
- Edit → Hydrogens → Merge non-polar
- Grid → Macromolecule → choose → 4m0eAprep.pdb 
- (creates 4m0eAprep.pdbqt)

Use Autodock tools to prepare input file of 
ligand for docking with Autodock Vina



l Select Key Residues that will be allowed to rotate during docking:
- Select → select from string (for 4m0e specific):
MET85  TRP86  TYR124  TYR133  SER203  GLU202  PHE297  TRP236  
PHE295  TYR337  TRP286  HIS447  PHE338  GLU450  TYR449  ILE451

Use Autodock tools to prepare input file of 
ligand for docking with Autodock Vina



l Flexible residues → Input → Choose macromolecule → 4m0eAprep.pdbqt
l Flexible residues → Choose torsions
l Flexible residues → Output → Save Flexible PDBTQ (4m0eAprep_flex.pdbqt)
l Flexible residues → Output → Save Rigid PDBTQ (4m0eAprep_rigid.pdbqt)

Use Autodock tools to prepare input files from your 
prepped protein for Autodock Vina



Assigning Dimensions for your Docking Search Space

l Use the grid box feature visualize what dimensions will encompasses the flexible residues 
you have selected and be appropriate to search for poten0al binding poses

l Grid → grid box
- Change Spacing to 1.000 (for Å)
- Adjust coordinates and size so that box encompasses flexible residues (aka binding pocket)
- Record dimensions and coordinates!! 

l These will define where the docking algorithm should look for potenTal binding poses
l You will need to put them into your configuraTon file 

- Close ADT



Setting up your config file and executing a docking 
simulation with Vina

config_4m0eA.txt

Create a configuration file in your favorite text editor (as 
shown on the left)

Assign: -flex file
-grid box 

coordinates
-grid box size
-exhaustiveness

Run your Docking Simulation in Vina on computing node!!
vina --receptor 4m0eAprep_rigid.pdbqt --ligand TPP.pdbqt --config config_4m0eA.txt --

log TPP.log

Coordinates for each pose and flexible residues will be in TPP_out.pdbqt

Summary tables of the results are found in TPP.log

For a summary of all the flags in vina type “vina --help”



l Use the xFLEXRESPREP script to add the coordinates of the ligand and flexible residues to the Rigid pdb for 
each pose:

./xFLEXRESPREP_v2 TPP_out.pdbqt 4m0eAprep_rigid.pdbqt

Use Chimera to protonate the structure (for docking we merged all non-polar hydrogens)
Open resulting pdb's in Chimera:
-Tools → Structure Editing → AddH
Check unspecified (determined by method)

Save structures as .pdb files (you will only need the top pose for this tutorial)

Combine the docking poses obtained from TPP4Cl_out.pdbqt with 
the Rigid receptor (4m0eAprep_rigid.pdbqt) to obtain a structure 

file for each pose bound to the receptor



Docking Results



Docking with Mcule
https://mcule.com/apps/1-click-docking/
1. Draw your ligand

https://mcule.com/apps/1-click-docking/


Docking with Mcule

2. Select your target



Docking with Mcule

3. Dock your ligand 



Docking with Mcule
Docking this way takes only a few seconds: 



Docking with Mcule

Visualize poses in Mcule or download for later use



Virtual Screening: Vina vs. Mcule vs. other 
soJware and approaches
• Generally, VS is good at finding the right geometries (poses), in agreement with X-ray 

structures, but not binding energies!
(Reasons? poor estimation of entropy and solvent effects – trade offs for speed)
• AutoDock Vina is regarded as more accurate than Mcule however it does take 

considerably longer to execute and system preparation is more complicated
• Vina gives more poses than Mcule
• For accuracy of virtual screening approaches see:

Warren, G. L.; Andrews, C. W.; Capelli, A. M.; Clarke, B.; LaLonde, J.; Lambert, M. H.; Lindvall, M.; Nevins, N.; Semus, S. F.; 
Senger, S.; Tedesco, G.; Wall, I. D.; Woolven, J. M.; Peishoff, C. E.; Head, M. S., A critical assessment of docking programs and 
scoring functions. J. Med. Chem. 2006, 49 (20), 5912-31.

Ferreira, L. G.; Dos Santos, R. N.; Oliva, G.; Andricopulo, A. D., Molecular docking and structure-based drug design 
strategies. Molecules 2015, 20 (7), 13384-421.
https://pubmed.ncbi.nlm.nih.gov/26205061/

https://pubmed.ncbi.nlm.nih.gov/26205061/


Ques%ons? 


